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Foreword

This manual provides an introduction to the basic Process Engineer
operations and functions.

While developing these functions we have made every effort to create a
clearly organized, easy-to-understand program structure.

A user-friendly interface as well as a clear menu guide will enable you to
quickly learn how to operate the program and to get familiar with its functions
so that you can carry out your planning tasks in a quick and reliable way.

No Liability or Guarantee

Our programs and manuals have been compiled with great care and to the
best of our knowledge. They have also been tested in a production setting.
However, we assume no liability and provide no guarantee that the software
and related descriptions are free of error or are suitable for special purposes.

DELMIA assumes no liability for any damage that may arise from the use of
this software. By using this software, the user acknowledges this exclusion
from liability and shall hold DELMIA exempt from all claims.

Copyright

The information in our documents may be copied and distributed for internal
purposes provided it is done free of charge and the contents are not altered or
distorted.

Any other form of usage, especially the sale on CD-ROM or in any other
publication in whole or in part is only permitted after prior written consent by
DELMIA.

Some parts of this software are owned by Unigraphics Solutions Inc. and are
copyrighted © 2010. All rights reserved.

Some parts of this software are owned by combit® GmbH and are
copyrighted. Report-/Print module List and Label® Version 8.0: Copyright
combit® GmbH 1991-2010.

Modifications
Moreover, DELMIA retains the right to make modifications and improvements
to the product described in this manual at any time without prior notification.

DELMIA and the 3DS logo are registered trademarks of Dassault Systémes or
its subsidiaries, in the United States or other countries.

© 2001-2010 Dassault Systéemes - All rights reserved
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1. Introduction

This manual explains how to use the Process Engineer for your planning
purposes.

1.1 How to Use this Manual

L)

This manual enables you to get familiar with the operation and functions of the
Work Pasitions. This manual briefly describes:

= Main menus provided by the Process Engineer
= How to start and exit the program

= How to execute menu functions and how to navigate in views

Note

This manual provides the basis for all further program modules. You will find a
more detailed description on how to work with these modules in the respective
manuals.

1.2 Documentation Conventions and Symbols

o
»
i

a

o

The symbols used in this manual are intended to provide you with keys to the
contents in an immediately understandable manner.

This symbol is used to introduce key concepts that are covered in the sections
immediately following this symbol. As a result, this symbol most frequently
appears at the beginning of chapters or sections.

Note

This symbol is used to mark notes, which provide you with additional
information you need to have for further work. You will either find the Note sign
at the beginning of a chapter or in a particular text passage in the chapter.
Texts bearing this sign are additionally marked with Note. The text is always in
italics.

Caution

This symbol indicates that the text that follows describes particular
circumstances that you must avoid to avoid potential errors with the operation
of the program or harm to data. You will either find the Caution sign at the
beginning of a chapter or near a particular text passage in the chapter. Texts
that are introduced by this sign are additionally marked with Caution. The text
is always in italics.

General Introduction Version PE 5.20
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m This symbol marks examples which serve to illustrate a certain situation.

1) This symbol marks the individual operational steps involved in a particular
operating instruction. Operating instructions describe operational steps, for
example, how to open a menu or execute a function.

« This symbol marks listed subjects. The symbol for listed subjects can be either
used to structure a continuous text or to list main subject keywords.

> This symbol marks list inside a bulleted or numbered list.

E‘ This symbol marks cross reference information that is available in another
manual.

1.3 New Functions in General Introduction

No new functionality has been added for this release.

General Introduction Version PE 5.20
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2. Starting and Exiting

The DELMIA Process Engineer can be started either from the start menu
(Please refer to the Figure 1) or by double-clicking the appropriate icon on
your desktop. To view the Process Engineer icon on your desktop link it to the
desktop using the start menu.

Once the program is started, you must log on with a user name.

' Programme

@ DELMIA

‘:T: »
{ 29 My Recent Documents 4 ‘d_) jo
2 Process Engineer
3
y » 5. ShutdownPPRServer
G Contral Panel 22 p_’ . DBAsisstant-Tools
) search » /77 , Server Tools
v ; . Setting Tool
@) Help and Support Starting the Process v
Engineer
7~ Run

CE=n

Figure 1: Starting the Process Engineer using the Start Menu or Icon

2.1 Logging on the Process Engineer

N

1) Enter the user name (admin) in Name field and password (admin) in
Password field. Always observe the upper/lower case as defined by the
administrator Please refer to the Figure 3.

2) If the upper/lower cases have not been observed when entering the user
name or password, a message appears

x

Access to DELMIA Process Engineer denied.
Please check your input!

Figure 2: Login Failed Message

3) When this message appears, simply click OK. Then enter again your
password and user name. Make sure you type them correctly. You can
repeat this procedure as many times as you want

Note

Your password and user name are registered by the administrator. According
to the user assigned rights, a user is given access to specific Process
Engineer functions. The administrator, for example, has access to all Process
Engineer functions and administrator is the only person who is authorized to
create user names and passwords. Please refer to the Figure 3.
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Language Ids

#* | ogin to DELMIA Process Engineer @

User Authorization

| Name iadmm
Password | seeee
Language |Languagel v

guag
Language2
Language3
Language4
LanguageS

Figure 3: User Authorization Dialog Box

4) Select the Language ID to store values of attribute in multiple languages.
For attribute to be multilingual, set the property Is Multilingual to Yes on
the attribute in the customization. If the attribute is customized as
multilingual and the required language ID is set while login, server returns
the corresponding value for the attribute.

If you want to translate and store the value in database then you can
launch two clients and store the value.

Multilingual will be supported only for attributes of datatype String and RTF
and control type Default, Edit, Multiline edit, and RTF Edit.

5) If no language ID is specified then the attribute will have the default
behavior and will not be stored or retrieved as Multilingual attribute.

Planning code {planningcode) ;I By Category  Alphabetical I
- Planning code {planningcode_crlF)
- Planning Yariant {planningyariant) Is generated key
- PoT-Curve {curvepob) |z key Mo
- Preassembly process (ispreassemblyprocess)
- Premises (premises)

Process Mame (name) |z printable Tes
- Process Number {(nameshort)

- Process Time C(allowancetime 33

Is Multi Lingual

|5 read only Mo

Figure 4: Property on Attribute

Finder also follows the language ID functionality. Please refer to the Finder
Manual.

Note

You can specify the language in poolingserverconfig.txt file. By default no
language is specified in the poolingserverconfig.txt file.

You have to edit the entry for the first time in order to enable the language
combo box to be displayed in User Authorization dialog box. Please refer to
the Figure 3. It is not recommended to give duplicate language ID’s.

<<multilingual>>

//List all Languages to be supported for external client
modules
client language:

language ids
['Languagel', 'Language?2', 'Language3', 'Language4’', 'Languag
eb5']

General Introduction
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You have to edit the entry for the first time in order to enable the language
combo box to be displayed. Please refer to the Figure 3.

The sequence of language is important and should not be changed once
specified. The first language specified is the default language and the other
languages are stored in Attribute value set table.

The languages updated in the poolingserverconfig.txt are updated in the
login dialog box. Please refer to the Figure 3.

All the calls using GetAttribute\SetAttribute and IEP_Query respects the
Language ID.

Important points about Language Id

Language ID is specified while logging (connecting) to the server. The
Language ID will be stored in transaction of the client connection and will be
used to get or set attribute through the client. If the default language Id is used
then the attribute will be handled in the default way i.e. if the attribute has a
physical name ex: “m_name” then the set or get of attribute will be from the
column in the database, if the different language ID is selected then the set
and get of attribute will be through attribute value i.e. the name will be
internally mapped by server to name_multilingual_delmia_1 for language 1
selected and name_multilingual_delmia_2, if language 2 is selected.

= If you want to change the language Id, re-login DPE.

= The language selected while logging is not same as the language
available in “Settings tool”, the entry in settings tool is for translation of
Static texts and not for the values.

= The property “Is Multilingual” can only be set on attributes of datatype
String or RTF type. The attribute cannot take more than 1000 characters
which are extendable to 4000 by extending the table size. This property
cannot be set for transient attributes. On storing of more characters than
the limits taken by database, then error message is displayed and no data
is stored.

= [f the control type is RTF then the decoration characters are also taken
into account for number of character calculation (total characters =
number of characters in decoration string + string length of actual data
string).

=  The language order once set should not be modified.

= There will be slight degradation in PCS as with this implementation more
data is stored in database and object tends to become heavier depending
on number of languages software is capable to handle and number of
“Multilingual” defined attributes.

= This property will not be taken care for attributes having special
implementation (e.g: extendedeffectivity, ehmh_status, attribute name on
type has etc).

= |f the “Is Multilingual” attribute is set on the Plantype level then General
finder cannot find the component with the attribute value. For this you
have to customize the attribute on type level. For example:

> If the attribute “name” on the plantype “Operation” is overwritten and
customized to be multilingual then the attribute property is bound to
plantype only. The project finder follows the customization and looks for

General Introduction Version PE 5.20
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the plantype and searched for the specific plantype.

General finder which is based on Type and not plantype will not be able
to know the customization and will not return the desired results for
multilingual search. To make the search successful the “Is Multilingual”
flag for attribute “name” on type “ergocompprocessdefault” is also to be

set to “Yes”.

2.1.1 Tools Menu

The executable functions in the Tools menu are generally not available to the
normal user. These functions can be executed only by a system

administrator.

Ny Ny NNy

DBAsisstant-Tools l
DBSupport-Tools

) Tools >

Server Tools
Setting Tool

Figure 5: The Tools Menu
Server Tools

The Server Tools monitor the IPD Server processes and manage information
on the logged-on clients. The server tools are installed on master and slave

servers.

1) You can open the server tools either from the start menu or by double

clicking symbol on the desktop.

B 1PDServer - Tools J

Connection VYiew Process monitor ‘Window Help

=10l x|

e x BE 2|

x| [Object manager succeeded.
Bl | menu page null succeeded.
Menultem MessageB ar succeeded.

<[] Information £ Warnings » Erors /[ 4 |

create object: EPServerT oolsUl. EPServerT oolsUIManager. 1

o

Ready

[ [Mum 7

Figure 6: Interface on Opening the Server Tools

Setting Tool

In the Setting Tool you can find the paths set when the Process Engineer was
installed. The paths can be changed after installation, i.e. upon the failure of a
computer or server on which the database is locally stored. The paths must

General Introduction
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then be changed to correspond to the new location where the database is

stored.
[Entry | Kevs Yalue A o 1
printing ‘genformname d:A\Programme\DELMIAAPPRClient\data‘Formulare’
printing genformbargraphname d:\Programme\DELMIANPPRClient\data\Formulare! | Cancel I
printing graficwindowform d:\Programme\DELMIANPPRClient\data\Formulare’
printing formbin d:\Programme\DELMIANPPRClient\datatMisc
printing  genfomergotimename - d:\Programme\DELMIA\PPRClient\data\Formulare”
graphic_editor cadpath d:\Programme\DELMIANPPRClient\datatcadpath
agraphic view_bitmaps d:\Programme\DELMIANPPRS ervertdatawiew_bitr
printing genformstationsheetname  d:\Programme\DELMIANPPRClient\data\Formulare’
printing genformbalancinglistname * d:%Programme\DELMIAAPPR Client\data\Formulare’
graphic_editor product_cadpath d:\Programme‘\DELMIANPPRClient\data\product_c

<« | »
Write settings Reset all

Figure 7: Setting Tools Dialog Box

The Setting Tool dialog box is required for both new installations of the
database as well as for updates. The standard settings are read from one file.
Items are displayed as soon as they are available in the database.

DBAssistant Tools

The DBAssistant-Tool is used for installing the Oracle database. The data
content and database structures are transferred upon both import and export.
In addition it is possible to align data with an upgrade and query as well as edit
support information and Oracle information.

ml Note

The DBAssistant may be used only by a trained system administrator.

|

rExchange————— ~Upgrade Databases Repair Database

" Import

" Upgrade - i

® gl Repair
r Collect support Information— — Switch oracle instances —

" Collect Information " Switch
[

OK I Cancel

Figure 8: Dialog - DBAssistant

2.2 Saving Data Permanently in the Project Database

To avoid any loss of data that have been created, changed, or added to a
certain project, save the data permanently in the project database.

General Introduction Version PE 5.20
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2.2.1 Saving Project Data

Project data can be saved in two different ways:
=  Using the menu

= Using the appropriate icon in the toolbar

Furthermore, you can enter a time interval for automatic saving. The automatic
saving process is always running in the background. You find the Settings
dialog box in the Miscellaneous tab of the Tools/Settings menu. The time
interval is entered in minutes. By default, the Process Engineer automatically
saves after every 10 minutes. Please refer to the Figure 9.

/. Settings L ;IQ] ll
-~
Cameratool | Printing... I Scripting I Other DS Software Modules | Configuration Tool I
Miscellaneous | Language/Logging/Paths ] Browser and Menu ltems l Process Client ] Table Yiew Graphic |
Save current size of this dialog v
Store current size of properties-dialog v
Auto-Save in Minutes |1 0

Figure 9: Utilities Menu — Saving Data Automatically

Saving Data using the Icon
The two icons are available to save project data:

r

D% Fle Edit Tools Miew Window Help

2 B O M = = ®

Figure 10: Save Data through Icon

g Use the Save icon to save transactions in the current window. This icon is only
active if a transaction has been performed that is relevant to the saving
process. Such transactions are creating new resources or changing data.

@ If you use the Save All Transactions icon, all performed transactions are
saved. For example, you may have opened and edited multiple views. This
icon is always active.

Saving Project Data using the Menu
Using the File menu (Please refer to the Figure 11) provides another
possibility to save project data. You can get the same result with icons also.

r&? Edit Tools View Window

MNew >
[Ej Mew Project Chrl+N
g2 Open Project Chrl4+0
'e Library Chrl+L

= save Chrl+S
ﬂ Save All Transactions

Close

Print Preview 4
Print 4

Exit

Figure 11: Saving Data using the Menu

If the Save All Transactions icon is inactive, you may have performed a
transaction which is not relevant for the saving process or there may be no
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hierarchical level selected in the PPR navigator. The icon gets shaded Please
refer to the Figure 12.

;j? Eile Edit Tools Wiew ‘Window Help

El N = = = B ®

Figure 12: Inactive Save Icon

2.2.2 Exiting the Program

x|

When you are closing a project or exiting a program with newly generated, yet
unsaved data, a program message prompts you to save the data.

Project: New_Projekt 1 x|

\:)/ Do you want to save your changes?
L]

Yes No I Cancel |

Figure 13: Prompt to Save Changes when Closing an Application

To exit a program, use the File menu or the Close button (cross symbol) in
the title bar. Please refer to the Figure 11.

2.2.3 Program Crash

a

a

Note

A program crash occurs when the entire hard drive space is used. If you have
any technical problems with the application, please contact our hotline service
team. (Please refer to the Foreword

The original database condition must be restored after each program crash .
Execute the ShutdownPPRServer program to ensure that all tasks that have
caused the program crash are stopped. You can activate the
ShutdownPPRServer program by using the start menu or the program icon
on your desktop (Please refer to the Figure 14). To view the
ShutdownPPRServer icon on your desktop link it to the desktop using the
start menu.

Note

There is no saving process in the case of a program crash. Only the most
recently saved planning situation is available after the crash.

1) Activate the ShutdownPPRServer or ShutdownPPRClient before
restarting the program after a crash. Please refer to the Figure 14.

General Introduction Version PE 5.20
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' Prograrmme

‘ \9 My Recent Documents »

& Control Panel »
'.) Search »

Q)) Help and Support

7~/ Run

& start|

Figure 14: Executing ShutdownPPRServer

& DELMIA

|® Tools

,;'3; Process Engineer

10

;,?\ ShytdownPPRServer

Y

Starting the Shutdown
PPRServer

p'? . DBAsisstant-Tools
p'-ﬁ Server Tools
p'?‘g Setting Tool

v
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3. Views in the DELMIA Process Engineer

The display of views in the Process Engineer is based on Windows
technology. If you are planning a digital factory, the Process Engineer
provides you with multiple main views for specific use in individual modules of
the program. A major benefit of the Process Engineer is the well structured
presentation of these views. This helps you to navigate in a confident manner
on all levels and quickly provides with the required results.

This chapter gives you a brief overview of the most important Process
Engineer views available for your work. For more detailed information on how
to execute the different program modules, Please refer to the appropriate
individual manuals.

3.1 Main Views in the Process Engineer

The Process Engineer provides you with the following views:

PPR Navigator

This view lists the basic procedures for the project you want to create. The
PPR Navigator is a global program module which is used for all individual
Process Engineer modules. The PPR Navigator displays and generates the
project structure. For your work with the PPR Navigator, you get the three
project views — Product, Process, and Resource View — as well as with a
Project Library and a Plan Type Set. Please refer to the Figure 15.

For more information on the PPR Navigator, Please refer to the PPR
Navigator Manual.

Product View

This view creates and displays the products you want to edit for a specific
project. The display is structured in a hierarchical way. The individual
hierarchical levels correspond to a bill of materials structure. The Product View
is only available in the PPR Navigator. Please refer to the Figure 15.

For more information on the product structure, Please refer to the PPR
Navigator Manual.

Process View

This view generates and displays the processes for a specific project. The
display is structured in a hierarchical way. Unlike the Product View, the
Process View allows you to open an additional view from the PPR Navigator.
Furthermore, the Process View provides the user with additional functions.
Please refer to the Opening Views from the PPR Navigator.

For more information on how to generate and work with a process structure,
Please refer to the PPR Navigator Manual and the Process Graph Manual.

Resource View

This view generates and displays the resources for a specific project. The
display is structured in a hierarchical way. Like the Process View, the
Resource View allows you to open an additional view from the PPR Navigator.
Furthermore, the Resource View also provides the user with additional
functions. Please refer to the Opening Views from the PPR Navigator.

General Introduction Version PE 5.20
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For more information on how to generate and work with a resource structure,
Please refer to the PPR Navigator Manual and the Manufacturing Concept
Manual.

Project Library

The Project Library lists all data that are used for a project and which are valid
only for this specific project. Changing these data will only affect the project at
hand. Please refer to the Figure 15.

For more information on the Project Library, Please refer to the PPR Navigator
Manual.

The System Library

The Library is the location where system elements or Plan Type Sets are
created. The Process Engineer uses the Library on a global basis i.e. the data
are available for all projects. Please refer to the Figure 42.

For more information on the Library, Please refer to the Project Library
Manual.

The General Search

The General Search is used to quickly find and provide data. Please refer to
the Figure 43. The General Search is equipped with specific search functions
related to a project.

For more information on the General Search and project-related search
functions, Please refer to the Finder Manual.

Minimising and Maximising Windows

Use these arrows to minimize or maximize a window. The arrows indicate the
direction in which you can adjust the size of a window. Furthermore, you can
use the left mouse button to move the window bar individually until you have
adjusted the required window size.

3.2 PPR Navigator View

The PPR Navigator is divided into two windows. The left window shows the
project structure along with the three structures — the Plan Type Set and the
Project Library. The right window is the display area providing several tabs for
display in the structure level to be selected. The display varies according to
your selection: either you can get a list (as displayed in the Figure 15) or a
Properties menu. Objects can be Processes, Resources, or Products. An
object is the more general definition of structure levels.

General Introduction Version PE 5.20
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[Menu bar | [Toolbars|

5 Fle Edt Yools View |window Help [Tabs| (@l
ot R @ A BEEEa® 2
= 4;- Né:«'ﬁf;r:i:rc:duct —— B BOM Enty | 55 Genefal| & Notes | 5§ Attachment |
- e s e

= 42{] MNew Process Planning, 1
Ej =5 Mew Process Plan, , 1

L-j 'ﬂ New Resource View, 1
&8 New Conceptual Planning, 1
[+ é MNew Company, 1

% Standard-SME

r_—}éﬂ Project Library
[455 3D States
[#-4Z§ 3D State position objects : Display area: Object
-4y Change Orders L properties or ohject list
[+-4Z4 Motifications 4 properties
[+ Planning States
#-4=4 Components
[+-4=4 Filter and Yariants
[+--4Z4 Project Premises
[ Utilities
#-4=y Template TO DO

< | i

27;\ Mew Rroject l

x| - matically saved data =
of | | PPR Navigator — |..; £pGtatuiiwin 1 =l

application range |‘erEPStatus'w/nd.1
‘er. EPStatugw/nd.1 j
uicawc uucu. L1 oawsoe el EPStatusiwnd. 1 x
<« | » | Information Warnings Errors M » I
Ready o o/
h 4 _" . h 4
Status bar PPR Navigator with :Messaqe:ls R

product, process, and
resource structure

Figure 15: General Structure of the PPR Navigator View

3.2.1 Navigating Views and Opening Menus

The PPR Navigator can be defined as the general control centre of the
Process Engineer. It is the starting point for most of the transactions in the
Process Engineer that are to be performed in the individual program modules
as the three-dimensional presentation of production lines or workstations, the
definition of location premises or also for the planning process of a production
concept.

The basic Process Engineer functions and operations can be summarized in
three items:

= Applying Mouse Techniques: Please refer to the Getting Familiar with the
Mouse.

= Opening the Process or Resource View: Please refer to the Opening Views
from the PPR Navigator.

=  Working with Menus and Context Menus: Please refer to the Working with
Menus.
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3.2.2 Getting Familiar with the Mouse

To use all Process Engineer functions in the simplest possible way, you
. should have a scroll wheel mouse with three keys.

| Applying Mouse Techniques

The mouse is one of the most important tools for your work in the DELMIA
Process Engineer. Hold the mouse in your hands during all operations to
choose options from the menu or to click buttons — buttons are usually used to
start program functions — you can also use the mouse when working with
context menus. Mouse is generally equipped with three operational keys — the
left, centre, and right mouse button.

Using the Left Mouse Button
You normally use the left mouse button for operation. If no other mouse button
is explicitly mentioned, always use the left key.

For left-handed users, the left mouse button function may be transferred to
another key. In this case, the functions are assigned in a mirror-inverted order.

You can use the mouse button in order to:

=  Open menus

=  Select options

= Activate dialog boxes and input fields
=  Highlight entries

= Start program functions using buttons

Using the Centre Mouse Button or the Scroll Wheel

The mouse wheel can be used like a key. You may operate the zoom function
in a three- or two-dimensional view. You may also use the scroll wheel to
display the complete contents from an open view. Normally, the view is
additionally equipped with scroll bars.

Using the Right Mouse Button
The right mouse button is mainly used to open context menus. Context menus
offer operational options in addition to the function currently activated.

Double-Clicking

You can use the mouse to double-click to start the Process engineer via the
icon on your desktop or to restore the original size of a minimized window.
Double-click means: clicking twice on an object with almost no time between
the two clicks. Double clicks are always made with the left mouse button.

3.2.3 Using the Center Mouse Button in a Graph

«®

Center
mouse button
is activated.

Using the center mouse button, you may navigate without limit vertically and
horizontally in a graph (as of PE 5.15). There is no limitation anymore, such as
that navigation is possible only to cell 282 when the zoom is set to 100%.

To Activate the Scroll Function

1) Click the graph with the center mouse button. The arrows indicate the
current direction of motion. You can navigate in eight directions.

General Introduction Version PE 5.20
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2) Navigate in the graph (horizontally or vertically) to achieve the desired
view.

3) To deactivate the scroll function, click graph with the left mouse button.

Zoom; 25 %
299 | 260 261 | 262 263 264 | 265 | 265 | 267 268 | 269 | 270| 271 | 272) 273 274 | 275 276 | 277 | 278 | 279 | 280 281 | 282 283 204 285

-

&} -} {at

11 | G (3} {3} 3 {3} -3} {3}

i ——————E——) b

mas) = M7

1
2
5
4
i
&
7
8 &)
: 1
10
1
12
13
Tl

Figure 16: Navigating in a Graph

3.2.4 Using Drag and Drop

=~
a)

Strg

You can execute three functions in the Process Engineer by drag and drop:
= Copy and paste

= Move
= Creating a reference

Copy and Paste
Copied objects remain in the source location and are copied to a target
location.

In the Process Engineer you can
= Copy objects within the same structure

= Copy objects between different structures
= Copy objects between projects with the same plantype set

Drag and Drop behaves similarly for all copy processes. You can learn more
about the behavior of drag and drop on two examples — copying within a
structure and between two projects.

In order to copy objects, press the left mouse button (standard assignments
for mouse buttons) and the control key.

Copying within a Structure
1) First select the object you want to copy — in Figure 17 the variant New
Variant 1 is selected.

General Introduction Version PE 5.20



iews in the DELMIA Process Engi 16

2) Press control key and hold until the object to be copied is added to the
target location.

3) During the copy process, the appearance of the mouse pointer changes so
that you can immediately see that a copy process is taking place

= “ H_andbuch_Projekt

[—j*:;ﬁ Mew Product Archive, 1 =~ 45‘ Handbuch_Projekt
L O B -Mew-Productt; =454 New Product Archive, 1
5', C 0 E® new Variant 1, 1 (- New Product 1, 1

) Mew Variant 1, 1

@ﬁ MNew AssemD
- g New Assembly 1, 1

=¥ New Product 2, 1

3 -2 New Yariant 2, 1 -8R New Product 2, 1
=) "Eﬂ MNew Process Planning, 1 @:: Mew Variant 2, 1
(=8 New Process Plan, , 1 ol |@ % Copy of New Variant 1, 1

Figure 17: Copying by Drag and Drop within a Structure

4) You can then stop pressing the mouse button and the control key. Now
you must confirm two messages.

5) Confirm the message with OK. The message shows that a copy process is
to be executed.

Confirm Operation 3 x|

“» , You are going to execute a copy operation.
\{/ Continue operation?

[You can disable this message in the settings dialog.)

! Cancel |

Figure 18: Execute Copy Message

Determine whether only the selected object (normal) is to be copied or the
structure of the object (deep) is also to be copied.

Copy Options 1 x|

1 Please select a copy option.

Mormal
Deep

MNormal I Deep I Cancel |

Parent Component Only
Parent and Child Components

Figure 19: Type of Copying — Normal and Deep

Confirm the message and the object is copied. (Please refer to the Figure 17
for copying of the New Variant 1).

Hiding the Copy Options Dialog Box
The customer_related entries enables you to determine if the Copy Options
dialog box should be displayed during the copying process (Please refer to the

Figure 19).
= |f the value is set to one, the dialog is not displayed during the printing
process.

= |f the value is set to zero, the dialog is displayed during the printing
process.
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= "GEE

17

Yalue = 1 is set, the
copy option dialog is
hidden

Select the
Current User

The entry
Customer_related is
selected.

= ComgE | ¥

& B «CEU«\\

+ DilogiSaes
EPCoriglodt

= EigoPlan
o clated |
31 Comex

Change the value:
Select the

disable_copy deep

entry. You can change
the value with the help of
— the edit button

+ Frorme

+ gaphc
waphee_arnotshon
paphe_edtor

gaphec_other
+ Ly

LmPropedy
+ Mubllzer

[Coe ] _cmee |

Figure 20: Set the Value — Hide the Copy Options Dialog Box
For more information on global settings, Please refer to the Settings Manual.

Copying between two Projects
It is possible to copy objects between two different projects by drag and drop
in the same way as one does within a project.

Copying between two different projects is possible only if both projects use the
same plantype set. You can copy single objects as well as entire structures
(partial projects). Moving and referencing between two projects is not
possible.

Note

When copying between two projects, time analyses in the source project are
not copied to the target project — when copying partial projects. However the
assigned rights of objects are copied.
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loix] o]
= o Project Source ] = P P_roject Target

B- "f{j New Product Archive, 1
- B New Product, 1
s

- % Standard-SME

[+-4=34 Project Library

=453 New Product Archive, 1
(= ¥ Mew Product 1, 1
P E fariant 1, 1

- &= New Product 2, 1
T 2

) H MNew Process Planning, 1
& 'ﬂ New Resource View, 1
-{® Standard-sME

[#-4=4 Project Library

=10l x|
= Q.r Project Target

5] *:53 New Product Archive, 1

: = New Product, 1

= &= Haube, 1

: LB New Yariant 1, 1

[ *3 Standard-SME

<23 Project Library

Figure 21: Copying Between Two Projects — Same Plantype Set

Translate
When objects are moved, they do not remain in the source location; they are
moved to another location (target).

In the Process Engineer you can

=  Move objects within the same structure
= Move objects between different structures
= Drag and Drop behaves similarly for all move processes

In order to move objects, press the left mouse button (standard assignments
for mouse buttons) and the Alt key.

Moving within a structure is demonstrated in the example given below:

1) Moving follows the principle of deleting (source) and inserting (target).

2) First select the object you want to move — in the example, Copy of car
body is selected.

3) Press the Alt key and keep it hold until the object to be moved is added to
the target location.

4) During the move process, the appearance of the mouse pointer changes
so that you can immediately see that a move process is taking place.

General Introduction
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-4 Project 4= Project

=423 Mew Product Archive, 1 =453 New Product Archive, 1
=] = &= Mew Product 1, 1
B fg Nel:ev Yariant 1, 1

ﬁ Karosserie, 1 e Ka e
= New Product 2, 1 % ﬁ Copy of Karosserie,

B New Wariant 2, 1 BQ Mew Product 2, 1
r@ -l Copy of Karosserie, 1 LB hew Variant 2, 1
A New P Planning, 1 7.l i
-4 Mew Process Planning, [+ H MNew Process Planning, 1
e 'ﬁ Mew Resource View, 1 & A4 New Resource View, 1
{9 Standard-KMU - 9§ Standard-KMU
[#]-<=5 Projektbibliothek [+ Projekbibliothek

Figure 22: Moving by Dragging and Dropping Objects

5) Release both the mouse button and the Alt key. You must now confirm a
message.

6) Confirm the message with OK. The message shows that a move process
is to be executed. Please refer to the Figure 22 for copying of the
Karosserie.

Confirm Operation x|

€» , Youare going to execute a move operation.
2 Contihue operation?

[You can disable this message in the settings dialog.)

Cancel

Figure 23: Execute Move

Creating a Reference

References are created in order to make other usages of a single object
possible. Other usages of objects means that all objects always have the
same properties: changes to one of the referenced objects apply to all objects.
Please refer to the Figure 26.

Referencing objects is different from copying in moving, in which objects can
continue to be edited independently and have no further reference to the initial
situation (at the source location).

System elements of the system library are referenced exclusively — for
example when a system element is linked to an object of the resource
structure.

Referencing
Referenced objects remain in the source location and are copied to a target
location. In the Process Engineer you can:

1) Reference objects within the same structure

2) Reference objects between different structures

3) Reference objects between system elements from the system library and
objects in the PPR Navigator

G) Drag and Drop behaves similarly for all processes. In order to reference
4 objects, press the left mouse button. No additional keys are required for
referencing.

Referencing within a structure is demonstrated in the example.
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1) The referencing of objects follows the principle of copying (source) and
inserting (target), and the reference to the source object is maintained.

2) First select the object you want to reference — in the example the car body
subassembly is selected.

3) Press left mouse button and keep it held until the object to be referenced is
added to the target location.

4) During the referencing process, the appearance of the mouse pointer
changes so that you can immediately see that a reference is being
created.

5) The corresponding structure is also copied, in contrast to copying and

moving.
= “ Project =8 o Project
[_:Jé} Mew Product Archive, 1 E]{fj New Product Archive, 1
E—] = Mew Product 1, 1 =¥ Mew Product 1, 1
e -::: Mew Variant 1, 1 r:]:: New Variant 1, 1
E]- car body, 1 ' Eﬁ car body, 1
_ - &9 part, 1
El= =& New Product 2, 1
Bk ) - Hew-ariont 24
& @ Mew Process Planning, 1 A ﬁ car body, 1
ﬁg»-ﬂ MNew Resource Yiew, 1 @ ﬁ part, 1
& ‘\3 Standard-SME - '@ Mew Process Planning, 1
r;ﬂ 2= Dvadack Likvavo rm M ko Dacaiwea Viam 1

Figure 24: Referencing by Dragging and Dropping Objects
6) Release the left mouse button. You must now confirm a message.

7) Confirm the message with OK. The message shows that a reference is to
be created. The target object is referenced by the object source.

Confirm Operation 3 x|

9 You are going to execute a link operation.
\{/ Continue operation?

[You can disable this message in the settings dialog.)

oK I Cancel I

Figure 25: Execute Link (Create Reference)

Referenced objects do not lose their reference to the source object. If you
change the names of the source or target object, the change will
immediately be executed for both objects.

If you delete a referenced object, all corresponding referenced objects are
deleted.
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Figure 26: Example: Name Changed - Linked Object

Mew Product Archive, 1

= Mew Product 1, 1

B- e Mew Variant 1, 1

[—] ’- car body new, 1

L & Part, 1

V&= New Product 2, 1

2% New Variant 2, 1
E.. :

w- 4 Part, 1
Mew Process Planning, 1

MNew Resource Yiew, 1
Standard-KMU
Projektbibliothek
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Drag and Drop between different Projects and Templates

N

Project to Top level as well as Not Supported Not Supported.
Project other components. For not top level
Copy Symbol appears components, though the “link
for non root level symbol” appears, the
component. operation is not supported.
Attempt to link would display
an error message.
Project to Top level as well as Not Supported Not Supported.
Template other components. For not top level
Copy Symbol appears components, though the “link
for non root level symbol” appears, the
component. operation is not supported.
Attempt to link would display
an error message.
Template to | Top level as well as Not Supported Both top level and otherwise
Project other components. supported.
Copy Symbol appears
for non root level
component.
Template to | Top level as well as Not Supported Not Supported.
Template other components. For not top level
Copy Symbol appears components, though the “link
for non root level symbol” appears, the
component. operation is not supported.
Attempt to link would display
an error message.
Note

You can COPY or LINK the components from “Project” to “Process Engineer

Client” and vice versa. MOVE is not supported for the same scenarios.

3.2.5 Opening Views from the PPR Navigator

To execute further functions for process or resource structures, the Process
Engineer provides individual views for these two structure types, i.e. the
Process View and the Resource View. Both structures are generated in the
PPR Navigator. The Product View does not require an additional view, as all
functions are executed by the PPR Navigator.
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PPR Navigator views are opened using the context menu (Please refer to the
Figure 27) of the right mouse button. Views can be opened from any
hierarchical level of the structure currently selected, i.e. process or resource
structure.

To Open a View

Note

m The procedure is the same for both structures. For example, you can move to
the Process or Resource View, if you want to create or edit a process graph or

a manufacturing concept.

1) Select the hierarchical level you want to work with from the appropriate
PPR Navigator structure.

2) Select Open in from the context menu.

i Ee Edt Tods Yew Widow bep =181
e rtRO A BEEa® T %2

= 4= Project

New »

Change Protocol
Versions
Calculation
Extra

Find Usage

Line Mumber

[#]- =% New Process Plan, ,
+ ﬁ New Resource View, 1
% standard-SME

+] {3 Project Library

Open in
Permissions

DPM (V5)
Process Engineer

Gut

Copy

Paste

Paste Reference

Set Insert Point

Fokaea o
Reload
2 Object(s) Refresh Sort Index [TThom [ 4
Modify sort index
Permissions. .

Print »

Properties

Figure 27: Opening Views from the PPR Navigator
3) Select the view you want to open (here: the process engineer).

The basic settings allow you to define whether you want the view to be firmly
linked to the PPR Navigator or whether you want the view to be available as a
separate window to be edited. The Figure 28 shows a situation where a firmly
anchored structure has been chosen as a basic setting. The range of functions
is the same for both settings. Depending on your personal preferences, you
may choose either of two methods for window presentation.
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[;_—J'

&

377 File Edit Tools View ﬂindowr Help ) =18l
|(aw E WO M EETa¥ 5w ?
=4y New Process Planning, 1 (=5 BOM Entry I-‘H Generall | Nolesl it I »

[+ MNew Process Plan, , 1
=5 New Process Plan, , 1

[Abbreviation I Version Mumber
= New OrgProcess 1
JIE new orgProcess 1

K8 | 3|
1 27, Project 2’ Processl
2 Object(s) [ [num 7

Figure 28: Open Resource and Process Views in a Firmly Anchored Structure

Navigating Horizontally and Vertically

Horizontal navigation (Please refer to the Figure 27) in the Process Engineer
means to open views from the PPR Navigator. Vertical navigation in the
Process Engineer means to open (Please refer to the Figure 29) process
structures. Thus, horizontal and vertical navigation describe the work direction
used between individual program modules or global functions such as the
Search (Finder) or the (System) Library.

To Open and Close Structures

To navigate horizontally or vertically, you can use (Please refer to the Applying
Mouse Techniques) the mouse.

1) Click the plus symbol in the structure. As a result, the next hierarchical
level gets open.

2) Click the minus symbol in the structure. As a result, the opened
hierarchical level gets closed.

{é] -d_'—'ﬂ MNew Process Planning, 1
. 5-BF ProcessPlant, , 1
: &}DE Process Flow, 1
G- B8 Process Plan2, , 1

Figure 29: Opening and Closing a Structure

3.2.6 Closing Views

The closing procedure of a view that has been opened from the PPR
Navigator, i.e. Process View or Resource View depends on the selected
settings. There are two possibilities for your work with views:

1) Either with a firm link to the PPR Navigator
2) Presenting views without any link

You can define this setting in the dialog: Select Clients should appear as a
Docking View from the Browser and Menu Items tab in the Tools/Settings
menu. Please refer to the Figure 30. Both views linked to the PPR Navigator
get displayed.
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[osettings ~1olx|
a
Graphic I Cameratool | Printing... ] Scriping | Other DS Software Modules ] Configuration Tool I
Miscellaneous | Language/Logging/Paths Browser and Menu ltems I Process Client I Table View I
Expand last open project in browser 12
Restore sorting in listviews o
Display property sheets style: lAII property sheets in a single row (scroll-bar) _:J
Select active default menu item | Properties dialog _'_]
Copy objects with rights o
Clients should appear as a Docking View v LI

Figure 30: Presenting Views in a Lose or Fixed Structure

Note

You cannot use the Close button (cross symbol) to close a view that is firmly
linked to the PPR Navigator. Views can only be closed using the File menu.
Please refer to the Figure 31.

Closing Views Firmly Linked to the PPR Navigator

If you work with a display structure that is firmly linked (anchored) to the PPR
Navigator, use the File menu to close an open view, i.e. Process or Resource
View.

You can only close an open view that is currently selected from the application
range. Please refer to the Figure 15.

Then select Close from the File menu. As a result, the open application gets
closed.

MNew »
‘2 Mew Project Chrl+h
g2 Open Project Chrl+0
'E Library Cerl+L
i save Chrl+S

ﬂ Save all Transactions

Print Pv;ggiew
Print 4

Exit

Figure 31: Closing a Firmly Anchored View — using the File Menu

Closing Views that are not Linked
Views that are not firmly linked to the PPR Navigator provide different options
to close a Process or Resource View:

1) Using the menu
2) Using the Close button (cross symbol) in the title bar
3) Using the Windows menu

4) Select the view you want to close
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== Process Plant, , 1 E BOM Entry | = Generall B Nolesl B Attachmenll
] E Process Flow, 1
# I Process Name l Process Mumber
DE Process Flow MNew Process
<

Kl — jid|

Figure 32: Resource View —not Firmly Anchored

The icon for window selection is only active if the views are not firmly linked
to the PPR Navigator or if additional functions such as the Search (Finder) or
the (System) Library have been activated.

When you activate this icon in the toolbar, the Windows dialog box opens
where all open functions and views are displayed.

To Close a View or Function

Select the required view from the dialog. Then click Close Window(s). The
selected view gets closed.

To Activate a View or Function

Select the required view from the dialog box. Then click Activate. The
selected view gets displayed in the foreground on your screen. Please refer to
the Figure 33.

Select window:

5 Handbook_project Cancel |
‘77 S Library
B8 Resource

Close Window(s) |

Cascade

Tile Horizontally

TileYertically

Figure 33: Windows Dialog with Open Views

3.3 Display Area

3.3.1 Specifying Individual User Settings

Anyone can arrange column headings according to the specific needs. This
arrangement remains unchanged until the administrator specifies a new
arrangement of column headings.

To Arrange Column Headings Individually

1) Left-click the column heading you wants to rearrange in the display area.
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2) Move this column heading to the new position.
3) Release the left mouse button. Please refer to the Figure 34.

| Alternativéhamative nb%cess fame
o Operation

Figure 34: Rearranging Column Headings

4) The column heading has now changed its position. Refresh the view.

l Alternative name  / ] Process Name l Process Number ] Labels l

Figure 35: Example — Individually Arranged Column Headings

5) Save these settings as usual.

3.3.2 Sorting Column Headings by Plantype

L)

At the beginning of a project, the default settings which have been specified by
an administrator with super user rights are available in the display area.

The arrangement of column headings in the display area can be changed by
locally in the project. For this purpose, there is no need for any super user
rights. Thus, everyone has the possibility to customize the work environment
shown in the display area according to his specific requirements. This means,
that locally, user rights and administrator rights are identical.

Note

An administrator with super user rights is allowed at any time to delete
column headings that have been individually arranged by a user. He can
assign new default settings. This may be the case, for example, if a
standardized solution is expected to yield better results or if there are plans to
completely redesign the display area.

Column headings can be sorted for a specific plantype in the display area
(called Listview in the information below). Only the Administrator may set up
the default settings for sorting column headings.

This arrangement of column headings by specific plantype in a Listview can
then be accessed by all other users within the project. Please refer to the
Specifying Default Settings by the Administrator.

Specifying Default Settings by the Administrator

To provide all users with default settings, the administrator saves all users in
the Database via the Store List Properties function after the column
headings have been arranged.

Process Mame | Process Mumber | Labels | alternative name

Figure 36: Example of Column Headings Arranged by the Administrator

The two functions Store list Properties and Delete Customer Settings may
only be executed by an Administrator.
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B i<t
E] 3 ] R ocess View, 1
53] @ Resource Yiew, 1
& -*.3 Demo PTS english
<3 Project Library

Tools Settings 4
Change Password... Chrl+w
Print Eorm 4

Store List Properties

Delete Project

Cleanup Graphic Directory

Merge Tool...

STM Time Update...

Import »
Database Utilities 4

Figure 37: Tools menu — Store List Properties

When the column headings have been arranged, click Store List Properties
in the Tools menu.

To distinguish this column arrangement by the administrator, the column
arrangements of the respective users are stored in the registration editor.

Refreshing the Listview
After storing, refresh the Listview to ensure that the new column arrangement
is active. Please refer to the Figure 39.

l Alternative name  / ] Process Name l Process Number l Labels ]

Figure 38: Example — Newly Arranged Column Headings

Select the project node and then press the F5 Key or select Reload in the
context menu of the project node. Please refer to the Figure 39.

Mew »

Change Protocol

Create Supplier Project

Edit Action Proxy and Mod Statement
Find

Save supplier: Project

Application

Coderules

Extended effectivities

Extra

Line Number

Permissions

Project

STM Standard Time Measurement

Gut

Copy,

Reference

tinsert Pont

Refresh Sort Index

Modify sort index

Permissions. .

Print 2

Properties

Figure 39: Refreshing the List View

3.3.3 Deleting Plantype-Specific Column Sorting

Again, only the Administrator may delete the default plantype-specific sorting
arrangement.
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b

Note

The menu item Tools/Delete customer settings is omitted from the Version
PE 5.12. The entries are now deleted in the new dialog box
Tools/Settings/Maintenance.

3.3.4 Copying the Display Area onto the Clipboard

-
v

Only the selected lines get copied onto the clipboard.

1) With the help of the Control key + A shortcut, all objects in the list are
selected.

2) You can select individual objects by pressing the Control key and the left
mouse button.

3) You can select all the intermediate objects by pressing Shift key and the
left mouse button.

4) Select one or several elements in the display area and open the context
menu.
I Component Name 2 I Component Number I Quantity | Planning State |
G Assembly 02 210-08-h-10 2,00 wWorking
G Assembly 02 Mew Product 1,00 working
G Assembly 02 MNew Product 1,00 wWorking
Bl Base-plate MNews Product 1.00  Working
arton Green C 25 36 Attributes at Same Time b
Fixing bracket 71 60 7 669 756 Change Planningstate a
P Frame Grey 71607669756  Change Protocol a
B=® Hood Printed 71607 426369 || 210w Graphic a
& Installation Instruction En... P 236 999 200 :Z:I;::;ons , 12
P Part 02 71 607 669 263 Calculation = q
H Part 06 13 50 6 769 869 q
P Extra 2

v Part Printed 07 71607 769 869 Find Usage » 19
& Purchase Part MNew Product Open » g
ﬁ Purchase Part 03 71607 215 987 Permissions » 19
1’ Support Material 013 21 00 2339 Reporting » 19
ﬁ Thermal Resistor 13 60 6 669 963 g

Cut

Copy

Paste

Paste Reference

Set Insert Point

Delete

Permissions. .

Copy Here

Copy to Clipboard

Print >

Properties

Figure 40: Context Menu: Copy to Clipboard

5) Select the entry Copy to Clipboard. The selected lines get copied onto
the clipboard. The entire display area is copied to the clipboard.

In order to continue to use the content of the clipboard, open Microsoft Excel

and select the entry Insert in the menu Edit.

The content of the clipboard is copied to Microsoft Excel. Please refer to the
Figure 41.
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EAMicrosoft Excel - Mappel

|=) File [Edt] View Insert Format Tools Data  Window Help  Adobe PDF

LD @ | ¥ Redo Typing Cirlbz: [ Meppel — — =0
|as 8D Can't Repeat Yy B D nomb EEL-O-A-. WY
Al

[ <O e STl I - [ H |
wVersionsnum Planungsstat Update lnfom Geanden -

“1'Working  new’ | DA.07.200517:12

o1 Working | 5 | D4.07.2005 17:12

— Working — new — D4.07.200517:12 .

. ‘AWorking  'DA07.200517:12 -

v ; 1 Working | new / D4.07,200517:12
g e 1 Woiking — W . 04.07.2005 17:12
9 TWoking  new  DAO720051712

W ‘ 1 Working | new 04.07.2005 17

4 1 Working— new ——— 0407.2005 17:12

5k | 1 Working | nw' Nﬂ?mw;ﬂl”
Y 1 Working now mumms !7‘12 |

=1 Working = =
T U o mm’ 2005 ‘!7 12

e

Figure 41: Example for Paste Data from the Clipboard

3.3.5 Library View and Search View

Library View
|E The (System) Library can be used for any project on a global basis.

The Library can be opened using the appropriate icon in the toolbar or using
the File menu.

E‘ The Library is described in more detail in a separate manual. Please refer to
=" the System Library Manual.

B- ',ai Library
- 4=y Datacards
= Eﬂ Plantypesets
= 3 Standard-SME

) 'ﬂ Resource Plantypes
'Eﬂ Process Plantypes
'ﬁ Product Plantypes
4= Script Actions
[#-4=3 Script Commands
£ Template
<3 Value Added
)% Default-¥SR16
+-4Z3 Planning States
+-4Z Raw Materials
i3 Scripts
‘3 Security Data
)l {ﬁ Waork System Components
+-43) ¥5 Catalog

o T O O e B
()

]

Figure 42: Library in the Process Engineer

Search View
The Search within the Process Engineer is an elegant means to quickly find
and provide data.

The General Search function can be opened using the appropriate icon in the
toolbar or using the Edit menu.

;=9 The General Search function is described in more detail in a separate manual.
m‘ Please refer to the Finder Manual.
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=T
IWovk Station Component ;I_I

Search | Additional Search | Fier

<< Search previous

I~ WSC Name [oke =1 _ Reset |
I Order Number juke =] | Save |
I Component Group ILIKE ‘1] I
I~ Price |= LI lD*UDC
I~ Supplier Juke = |
I Catalogue JLIKE =1
I Minimal \width = ~] [0.00mm
I™ Minimal Height = | [0.00 mm
I~ Minimal Length = ~| [0.00mm
I Diameter = | [0.00 mm
I~ weight = > [0.00kg
I~ Last Update = ~1 |os.10.2005 =l
I~ Model Juke =]
I Equipment JuKE =1
| WSC Mame | Order Number I Price [€] I Supplier -~
7P werkbank 1300x750x840... M4-8013-16 0,00 Fami
% wWerkstuecktraeger 400x3... LWB2422LF 0,00 Stucki
?‘ Einsatzkasten 130x180x8... LWB2261LF 0,00  Stucki
é“_f Flaechenleuchte 3.13-E1L909 383,01 Mavytec &
=7 Flaechenleuchte 3.13-E1L917 438,13 Maytec
“7  Dreifachleuchte 3.13-E3K920 612,48 Maytec
‘}_ﬁ Dreifachleuchte 3.13-E3L908 640,60 Maytec
1$ Ergonomischer Drehstuhl ...  1133-R 9990,00 Fami
1‘;? Ergonomischer Drehstuhl ... 1134 0,00 Fami
1.}7 Drehstuhl h=445-650mm 1116 0,00 Fami
11;,; Arbeitsstuhl h=550-760mm 1127 0,00 Fami
ﬁl;'f Drehstuhl h=540-750mm 1130 0,00 Fami
‘?} Transportbehaelter 1200x... 7724-11E 124,24 Braucke
ﬁ AARAC P dbbic —h 1 0ANLE AN 100 nAon > | 1692 00 Varamlav 1 n;-»:lLl
< >

1 to 50 of 1872 found

Figure 43: General Search Display

3.4 Working with Menus

The Process Engineer provides three basic menu types:

= Main menus in the menu bar
= Right mouse button context menus
= Function dialogs

(o) This section of the chapter provides you with an introduction to basic
\;(" operations of the different menu types. For project-related information on
menus and functions, Please refer to the respective manuals.

3.4.1 Main Menus

The main menus are used to activate the basic functions in the Process
Engineer. The main menus can be opened from the menu bar.

-1oOl x| These three symbols in the title bar are used to minimize, close, or maximize
the current window.

‘975 File Edit Tools View Window Help

et U@ A BESa® v %2

Figure 44: Menu bar Featuring the Main Menus

File Main Menu
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This menu can be used to (Please refer to the Figure 45) open a new project,
to save a project or to exit the Process Engineer. This menu is mainly used for
project-related work.

New »
2] Mew Project Ctrl+n
g2 Open Project Ctrl+0
'E; Library Chrl+L
H save Chrls
ﬂ Save All Transactions

Close

Print Preview 4
Print 4

Exit

Figure 45: Functional Range — File Main Menu

Activating Menu Functions
Perform the following steps to activate functions from a main menu:

1) To open a main menu, select the required menu from the menu bar
(Please refer to the Figure 44). To do this, use the left button of your
mouse to click the required menu item.

2) To activate a function in the main menu, select the required function from
the main menu. To do this, use the left button of your mouse to click the
selected function.

3) If you want to activate a function along with additional functions please
select another function from the menu. These functions are also marked
with an underscore in the main menu.

4) Move your cursor (Please refer to the Figure 46) to the additional menu
and left-click on one of the functions offered.

Settings 4 |

Change Password. .. Chrl+w

Store List Properties fiew Object
Mew Graphic Window
Edit List
Edit Gbject
Edit Graphic Window
Configuration for Graphic
Delete object
Scriptvariables

Figure 46: Functions with Additional Functional Range
Edit Main Menu

You can use this menu (Please refer to the Figure 47) to copy transactions
from a project, to open properties of a selected object or to assign specific
access rights for objects. Furthermore, you can start the General Search. You
can also use this menu for any specific, project-related work.
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Ut Chrkex

CtrHC

ChrlY

Delete
Select all Ctrl+a

Copy to Clipboard

&4 Find Ctrl+F

ﬁ Open in Table Yiew
m Findim Table Yiew

Properties Chrl+T

Permissions. . Cerl+M

Figure 47: Functional Range — Edit Main Menu

Tools Main Menu

You can use this menu (Please refer to the Figure 48) to define the basic
settings for the Process Engineer, to select print forms, to delete a project, or
to import data. Moreover, the Database Utilities menu item provides you with
configuration utilities and the user management. This menu is mainly used for
general work in the Process Engineer that is not related to a specific project.

Settings 4
Change Password. .. Chrl+w
Print Form »

Store List Properties

Delete Project

Cleanup Graphic Directory

Merge Tool...

STM Time Update...

Import »
Database Utilities 4

Figure 48: Functional Range — Tools Main Menu

View Main Menu

You can use this menu (Please refer to the Figure 49), to show and hide the
toolbar or the browser window. You can mainly use this menu to provide
different views for your work with the Process Engineer.

Toalbar 4 ,W Main Toolbar
r/ Status Bar
B Message Window

Figure 49: Functional Range — View Main Menu

Help Main Menu

You can use this menu (Please refer to the Figure 50) to access any available
manuals from the program. You can mainly use this menu whenever you need
help on a specific subject. The yellow question mark provides you with
updated information about the currently installed Process Engineer version.

Contents

? About DELMIA Process Engineet...

Figure 50: Functional Range — Help Main Menu
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3.4.2 Function Menus for Program Functions

N

Note

In addition to the main menus shown, the Process Engineer provides further
menus. These menus are only available for specific functions of a program,
such as when working with graphic or camera tools.

Function Menu - Graphic
This menu is available only when you edit a graphic.

Graphic Window Help

Graphicsettings. ..
QuickCam >
View 4
Tools 4
Mavigation 4
Grid 4
Zoom 4
Stereo (s)
Show Floor
Invert Selection

Export

[—Vw Show axes of selected objects

Figure 51: Functional Range — Graphic Function Menu

3.4.3 Context Menus, Dialogs, and Properties Menus

In addition to the hierarchical level selected, a context menu provides
functions that you may require or use for your current work process. Dialogs
either provide displays for a specific subject or you can enter data in these
dialogs. Properties menus define data for a specific object, i.e. for a project.

Opening Context Menus
Context menus are accessed using the right mouse button.
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SN Ee Edk Tooks Wew Window Hep =18]x]|
(e tEO AEE =™ %2

Foied Id;Geneldlt'vFlel

@ New  New »
o Ch Protocol {Proiec{
0 Net ange Protocol —
o) g sta  Create Supplier Project ‘[NM Bk
+ 3 Pro Edit Action Proxy and Mod Statement r

Find be Autorelations [

Saye supplierProject

Application

Coderules

Extended effectivities

Extra

Line Mumber

Permissions.

Project

STM Standard Time Measurement

vy v VvYvvywvwyyw

Ready Reload [
Refresh Sort Index
Modify sort index
Permissions..
Print »

Properties

Figure 52: Opening a Context Menu using the Right Mouse Button

To Open a Context Menu

1) Use the left mouse button to select the hierarchical level from where you
want to open the context menu.

2) Press the right mouse button.
3) The context menu opens. Please refer to the Figure 52.

4) To activate the functions provided in the context menu, left-click one of the
available functions.

Dialogs in the Process Engineer

All program modules provided by the Process Engineer use dialogs in the
context of currently used functions. The following two examples illustrate the
use of dialogs.

m Example of a Display — Find Usage

This example shows the usage of the selected Resource View. The individual
tabs provide you with further information. The tabs may change with each
dialog or also with a selected hierarchical level.

To obtain information about a specific tab, Left-click a tab to view the tab
information required.

SSEe B Tods Vew wndow Heb el
DS TED M EHETS=a® Y w2
-4 New Resource Yiew, 1 EA Conceptual Planning |é Company' “ Pmiectl 4 General! 24 Note s | »
é New Company, 1 s s 5
S ‘4 I Abbreviation I Simulation script I ersion Number
&8 New Conceptual Planning, 1 ; =
[+ P Project MNew OrgResource 1
4
\»
§
< o] fLed | i
gp‘- Project g), Resource 5% Find Usage Data: New Resource View, 1 I
Ready [ 4
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Figure 53: Find Usage — Resource View

Example of Entered Information — User Management

The User Management dialog allows you to enter data, for example, to create
a new user or to delete a user. For more information on user management,
Please refer to the Administrator Manual.

The following functions of this dialog are executed by the administrator:
» To create a new user, you must open the User menu.

= To assign rights, you must open the Rights menu.

x
User Rights
User name I Description I
s.} admin Administrator
€ oM
€ Usert

|§oup hame I Description I

al Everyone All users are members of this group

Figure 54: Editing the User Management

Opening Properties Menus

The Properties menu is available on almost all hierarchical levels. Properties
menus are accessed using a context menu (Please refer to the Figure 52) of
the selected level. The following example illustrates the use of a Properties
menu.

Project Properties Menu — General Tab
Tabs may vary for each Properties menu. Tabs are provided according to the
hierarchical level selected.

The General tab defines general Properties data. In our example, these
Properties data relate to the current project.
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Exanple

Bl Project <Project> 10 x|
General | Filter | Notes | i

Project Hame IFroiect

Project Number lNew Proj.

“wite Change Protocol g |

Automatically Synchronize Autorelations [V

Allow Parallel “ersions =

Allow Time Update g |

— Organizational Data

Customer Shortname

Responsible Department

Inquiry Mumber

Quotation Number

Project Type

Delivery Address

Customer Department

|
|
|
|
Order Number I
|
|
|
|

Customer “Workshop

— Ti P

Modified |07.10.2005 12:47:54

Created 06.10.2005 08:48:38

- 1
I oK I

Cancel I Aoply I Preview I Print

Figure 55: Project Properties Menu — General Tab

Project Properties Menu — Filter Tab

36

The Filter tab defines filter information. This is helpful, for example, if you want
to view a display that has been selected according to special filter criteria.
Filters can be coderules, production numbers, or coderule macros. The Filter

tab is only available in the Project Properties menu.

Bl Project —Project>

General Filter I Motes |

Coderule Mode

Standard Mode with operators [ ] - + /

Coderule Type | Relative
Is CMC Detached Mode —
Is CMC Mode T

Show &ll Top Level Versions [
E=xtended Effectivity Settings IENDVIA_SYNTA.'K_ALLDWED=1
Filter Mode

Iignole if filter type missing

— Current Filter

Effectivity Begin Date

Effectivity End Date

Extended Effectivity Filter

Process Filter

Product Filter

Attribute Process Filter

Attribute Product Filter

Attribute Resource Filter

Label Filter

|
|
|
|
|
Resource Filter I
I
|
I
I
I

Line Number Filter

Preview I Print

T

Cancel I Apply I

Figure 56: Project Properties Menu — Filter Tab

Note

You can change a filter on a project from project properties dialog box, only if

the project is opened with a filter.
Project Properties Menu — Boundaries Tab
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The Boundaries tab defines information about the workers, production
processes, and the papers required. This information applies to the entire
project. The Boundaries tab is only available in the Project Properties menu.

The boundaries tab in project properties is hidden by default.

i Project <Handbook_project= =10l
General | Fiter | Boundaiies | Notes | =
~worker (— Production
MNumber of Employees I':I Production Technology I
MNumber of Men IEI Conveyor Element I
Mumber of Women Jo Transport Container [
Number of Skilled Workers IEI Area per Station IU,UU e
Number of Semi-Skilled Workers IEI Total &rea IU,UU e
Wage Structure Production kiethod
Payment System Production Depth [steps] [0
Abzentesism Planning Cycle [months] [0
Fluctuation ‘wharking Time 0.00h
Nurber of WorkPlaces [
Number of Workplacs Typss [0
—Paper.
Praduction Papers I
Test Sheets I
Acknowledgement Feceipts |
[ ok | cancel | Print |;

Figure 57: Project Properties Menu — Boundaries Tab

m Project Properties Menu — Notes Tab

This tab is virtually the subject heading of the Properties menu. The Notes tab
allows you to write important information concerning the Properties. The
information you type in this field only makes sense if it corresponds to a
subject from the hierarchical level selected. In our example, this applies to any
project-related information. This tab is available for all Properties menus.

The context menu allows you to change the size, font, or color of the
characters used.

To do this, highlight the typed text and press the right mouse button.
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+ Project <Handbook_project= g = 3]

|»

General | Fiter | Boundariss Notes

Nates  |Here can you write important information

oK I Cancel | Apply | Preview Print |;

Figure 58: Project Properties Menu — Boundaries Tab

Using the Next and Previous Buttons in the Properties Dialog

With the help of both the Next and Previous buttons of an opened properties
dialog, you can display and even change the properties of PPR-components in
another opened structure.

By using this procedure with the help of the opened properties dialog you can
move forward or go back in an opened structure. The PPR-component
properties that you move to are always the ones that are displayed. The PPR-
component with the properties dialog that was opened first remains selected.

1) Open up a structure in the PPR-Navigator.
2) Select a PPR-component in the structure — Process 002 in the example.

I=E CE Process Flow, 1

The Next and Previous buttons
enable you to move around in the

3
[Fhs A

m ¥ T 003, e opened properties dialog of a
-3 004, 1 b structure, and display the
- T 005, 1 individual properties of the PPR-
i component.

-Iam 007, 1 ¥

&3]

Figure 59: PPR Component
You can open the properties dialog via the context menu.
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=lal

|x

I Operation <P2, 1>

|»

General ]Time I Balancingl Simulationl Analysis Lines] Notes I Wersion Information | Value Addedl Effectivilyl Allacﬂ_’[

Process Name |002

Process Number MNew Process

Classification Standard Process :‘
has Process Graph

Premises

|
Allowance Set |

I

|

PoT-Curve
‘wirite Change Protocol [~

Calculate &llowances [~

Ti

Modfier | admin

Creator | admin
Created | 24.03.2006 08:18:03
Modified |24.03.2006 11:27:54

| 0K I Cancel | Apply | Preview I Print I Next | Prev I

Figure 60: Example — the Properties Dialog of a Process

3) Click Next button — the properties of the Process 002 are displayed. If you
i I want, change the displayed properties of the Process 002.

4) You can save any changes without closing the properties dialog box.

5) Confirm the message with OK in order to save the changes. This message
appears only if you have made changes. Please refer to the Figure 61.

x
\‘)) Save changes?
-
Yes No l

Figure 61: Save Changes Message
3) If you want to display the properties of the previous process, click

Prev I .
Previous button.
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